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File Menu

New
Save
Save As
Print
Exit



Edit Menu
Copy To Clipboard



Data Menu

Bring Data Sheet to Top
Data Sheet Always on Top



Graph Menu

Change Graph Type
Show Grid
Display X-Axis Labels
Thick Lines
Explode Pie Chart
Hypersound
Change Hypersound WAV File



Text Menu

Add Title
Change Title
Remove Title
Add Legend
Change Legend
Remove Legend



Colors Menu

Graph Background
Graph Foreground



File - New

Creates a new graph.    To enter the information for the graph, bring the data sheet to the top, enter the 
relevant information and click on the graph button.

SEE ALSO

Bring Data Sheet to Top
Save



Data Sets

A data set is a group of related data.    For example, the sales of Widgets for a fiscal year would be a data set; the sales for each 
month in that year would be a data point in the set.



Data Points

A data point is one element of a data set.    For example, the sales of Widgets for a fiscal year would be a data set; the sales for 
each month in that year would be a data point in the set.



File - Save

Saves a file.    If you have not previously saved the graph you are working on, the File Save dialog box 
appears.    Enter the relevant information and press OK; the graph is saved in Windows MetaFile format 
for importing into your wordprocessing, spreadsheet or presentation applications.    The new file name 
appears as part of the window caption.    If you have previously saved a version of the graph you are 
working on, Steve's GraphMaster saves the most current version of your graph to disk.

SEE ALSO

New
Save As



File - Save As

Saves a file; causes the File Save dialog box to appear.    Enter the relevant information and press OK; 
the graph is saved in Windows MetaFile format for importing into your wordprocessing, spreadsheet or 
presentation applications.    The new file name appears as part of the window caption.    This option allows
you to save a copy of a graph under different names.

For example, you create a graph with widget sales for the first quarter and call it QUARTER1.WMF.    
Then you add the sales information for the second quarter.    Select Save As from the File menu, and 
name the graph QUARTER2.WMF.    Operating in this manner saves the time and trouble of rekeying 
information.

SEE ALSO

New
Save



Windows MetaFile Format

A type of Windows file format commonly used for files that are going to be displayed as graphics.    Its main advantages are that it is 
well integrated into Windows and it can be displayed and resized very easily.



File - Print

Prints a graph.    Selecting this option brings up the Print Options dialog box.    You have two options from 
which to select:

* Printing to a black and white or color printer
* Printing the graph with a border around it

After you select    options, the graph is printed.



File - Exit

Exits Steve's GraphMaster.    If you haven't saved a copy of the graph yet, you are prompted to do so.    If 
you choose No, Steve's GraphMaster closes down.    If you choose Cancel, you are dropped back into the
Steve's GraphMaster editing mode.    If you choose Yes, you are prompted with the File Save dialog box.   
Type in the relevant information and press OK.    The graph is saved and Steve's GraphMaster closes 
down.

If you have already saved a copy of the graph you are working on, Steve's GraphMaster simply closes 
down.



Edit - Copy To Clipboard

Copies a picture of the graph to the Windows Clipboard.    Once a copy of the graph has been placed into 
the clipboard, it can be pasted into other Windows applications.



Windows Clipboard

A place where information from one program can be stored until it can be transferred to another program.



Data - Bring Data Sheet to Top

This option brings the data sheet on top of the graph window.    The data sheet is where new information 
can be entered and graphed.    To graph new data, do the following:

1.    Enter your data in the data sheet.

2.    Highlight the data you want to graph.    If you want to include labels for your X-axis information, 
you can enter text along the top row of your highlighted information.

3.    Click on the graph button.

Steve's GraphMaster redraws the graph based on the information you have highlighted.    If you want to 
change information that has already been graphed, such as data point values, X-axis labels, or column 
colors, you can double-click on the graph or click on the Browser button.    It brings up a window with 
information pertaining to every column of data in the graph, from which you can change any aspect of the 
data.

SEE ALSO

Data Sheet Always on Top



Data - Data Sheet Always on Top

Selecting this option brings the data sheet window on top of the graph.    In addition, it makes the data 
sheet window float on top of graph at all times, regardless of which window you are working in.

SEE ALSO

Bring Data Sheet to Top



Combo List Box

A Windows object that features a rectangular box with a down-arrow on the right.    If you press on the 
down-arrow, a list displays with valid items for the combo list box.



Graph - Changing Graph Types

Changes the graph type.    When you select this option, a dialog box appears with a list of graph types 
and a picture of each one.    To select a different graph type, do one of the following:

* Double-click on the picture of the graph you want to select.
* Click on the picture of the graph you want to select and click on OK.

The dialog box disappears and the graph is redrawn according to the type you specified.

(NOTE:    If you have more than one data set and then change the graph type to 2D-Pie or 3D-Pie, the 
chart displays a graph based on the first data set only!)

SEE ALSO

Show Grid
Display X-Axis Labels
Thick Lines
Explode Pie Chart



Graph Type

The type of chart that displays;    some examples are 2D and 3D-Bar Charts, Line Charts, Area Charts, 2D and 3D Pie Charts, etc.



Graph - Show Grid

Toggles graph grid background.    This menu option acts a toggle to switch between showing a grid in the 
graph background and not.    By default, no grid is shown.    To turn the grid on, select Show Grid from the 
Graph menu;    the Show Grid item becomes checked and a grid displays in the graph background.

To turn the grid off, simply select Show Grid again; the Show Grid item becomes unchecked, and the grid 
disappears from the graph background.

SEE ALSO

Change Graph Types



Grid

A grid is a series of lines that enable you to visually see numeric watermarks, such as where 150, 250 and 350 are located at in the 
background of a graph.    It is a means of increasing the accuracy of one's visual interpretation of a graph.



Graph - Display X-Axis Labels

Toggles between showing and hiding X-axis labels.    X-Axis labels appear across the bottom of the 
screen on most charts; the exceptions are pie charts.    On pie charts, X-axis labels appear as text labels 
for slices of the pie.    By default, X-axis labels are displayed.    To turn them off, select Display X-Axis 
Labels from the Graph menu.    Display X-Axis Labels becomes unchecked, and the labels disappear.

To turn the labels back on, simply select Display X-Axis Labels again; the labels reappear and Display X-
Axis Labels becomes checked.

Probably the only situation where you would want to turn of X-axis labels would be if you were adding a 
legend to the graph.

SEE ALSO

Change Graph Type
Add Legend



Graph - Thick Lines

Toggles between thick and thin lines on a line-type graph.    This option is only available if you have a Line
or Log/Line type graph; the default is to have thick lines turned off.    To turn thick lines on, select Thick 
Lines from the Graph menu.    Thick Lines becomes checked, and the graph is redrawn with thicker data 
lines.

To turn it off, simply select Thick Lines again; Thick Lines becomes unchecked, and the graph is redrawn 
with thinner data lines.

SEE ALSO

Change Graph Type



Graph - Explode Pie Chart

Explodes slices of a pie chart.    Use this option to explode slices of a 2D or 3D pie chart.    For example, 
to explode the third item in a pie chart, do the following:

1. Select Explode Pie Chart from the Graph menu.    Data from the pie chart is organized into 
columns and displayed.    You are then prompted to with a combo list box and asked to select the 
column you wish to change.

2. Click on the number representing the slice of pie you want exploded from the chart.    Steve's
GraphMaster calculates the effect and then redraws the graph.

You can repeat this procedure to explode as many pieces of the pie as you wish.

SEE ALSO

Change Graph Type



Explode

To pull a slice of a pie chart slightly away from the circle.    This makes the slice stand out from the rest, and is a way to add 
emphasis.



Graph - HyperHelper

The Hyperhelper menu selection has two functions.    First, it displays the name of the file that you have 
defined as your default WAV file for the Hyperhelper feature.    If you don't explicitely specify, GraphMaster
uses a WAV file called HYPERHLP.WAV.

Secondly, the menu selection acts as a toggle between having the WAV file play when using the 
Hyperhelper feature.    If a checkmark appears next to Hyperhelper, then the WAV file will play when you 
use Hyperhelper.    If no checkmark appears, the WAV file will not play.    Simply selecting the menu item 
toggles Hyperhelper's WAV playing feature off and on.

If the Hyperhelper menu selection is grayed out, that means that your system is not capable of playing 
WAV files.

See Also

Changing the Hyperhelper WAV File



Graph - Changing the Hyperhelper WAV File

Selecting this option brings up a dialog box from which you can select a new WAV file to have 
Hyperhelper play when utilized.    When you select a new WAV file, GraphMaster remembers your 
selection and will continue to play it when using Hyperhelper until you either change the WAV file or 
toggle Hyperhelper's sound feature off.

SEE ALSO

HyperHelper



Text - Add Title

Adds a graph title.    Use this option to add a title to the top, bottom or left of the graph.    To add a title, do 
the following:

1. Select Add Title from the Text menu.    You are prompted to enter the title text.

2. Type the text of the title, up to a maximum of 80 characters.    You are prompted to select the 
location where the title should be placed.

3. Select either Top, Bottom, or Left and click the OK button.    Steve's GraphMaster calculates the 
title placement and redraws the graph.

NOTE:    If the title is too long to fit in the space you specify, it is not displayed.    Try changing the title to 
get the text to appear.

SEE ALSO

Change Title
Remove Title



Text - Change Title

Changes a title.    Use this option to change title text or move an existing title to the top, bottom or left of 
the graph.    To change or move a title, do the following:

1. Select Change Title from the Text menu.    The existing title text appears in a box, and can be 
changed.    You can also select a location where the title should be placed.

2. Click the OK button.    Steve's GraphMaster calculates the title text and location and redraws the 
graph.

NOTE:    If the title is too long to fit in the space you specify, it is not displayed.    Try moving the title again 
to get the text to appear.

SEE ALSO

Add Title
Remove Title



Text - Remove Title

Removes a title.    Use this option to remove a title from anywhere on the graph.    To remove the title, 
simply select the option from the menu.    Steve's GraphMaster searches out any and all titles and deletes
them.

SEE ALSO

Add Title
Change Title



Text - Add Legend

Adds a legend.    Use this option to add a legend to your graph.    To add a legend, do the following:

1. Select Add Legend from the Text menu.    A dialog box appears with default Legend text items.

2. Enter the legend text for each item.    If you want the legend text to appear in the same color as 
the legend block, check the box at the bottom of the Window and press ENTER.    Steve's 
GraphMaster calculates the legend information and then redraws the graph.

SEE ALSO

Remove Legend



Text - Change Legend

Selecting this option brings up the Legend dialog box.    In it, the legend text for each data point or set 
appears.    To change it, simply type over the existing text and click on the OK button.



Text - Remove Legend

Removes a graph legend.    To remove a legend, simply select the Remove Legend option.    The legend 
is wiped away and the graph is redrawn.

SEE ALSO

Add Legend



Colors - Graph Background

Changes the graph background color.    To change the color, do the following:

1. Select Graph Background from the Colors menu.    A dialog box appears with a list of colors.

2. Click on the color you want for the graph background.

3. Click on the OK button.    Steve's GraphMaster calculates the colors and redraws the graph with 
the new background color.

SEE ALSO

Graph Foreground



Colors - Graph Foreground

Changes the graph foreground color.    To change the color, do the following:

1. Select Graph Foreground from the Colors menu.    A dialog box appears with a list of
colors.

2. Click on the color you want for the graph foreground.

3. Click on the OK button.    Steve's GraphMaster calculates the colors and redraws the graph with 
the new foreground color.

SEE ALSO

Graph Background




